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Kartki vodic za editiranje slika
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u v o d

Photoshop je profesionalni grafički 
program za obradu slika, a razvio 
ga je Adobe Systems te je postao 
sinonim za digitalnu obradu slika 
i često se koristi kao glavni alat 
za profesionalce u područjima 
dizajna, fotografije, ilustracije i 
srodnih poslova. 

Iako je izuzetno moćan i fleksibilan, 
zahtijeva opsežno učenje kako bi 
se maksimalno iskoristile njegove 
brojne značajke i mogućnosti. U 
ovoj skripti nećemo samo nabrajati 
koje alate i opcije imamo pa kratko 
opisati što se s tim radi jer smatram 
da je to najdosadniji način učenja 
i na taj način definitivno ubijamo 
volju i gušimo motivaciju i maštu. 

Ova skripta će prolaziti 
najosnovnije stvari, ali kroz razne 
primjere i savjete, više intuitivno 
nego kroz suhoparno nabrajanje.

Uživajte u čitanju, učenju i 
eksperimentiranju...
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R E Z O L U C I J A  i  D I M E N Z I J A  S L I K ES A S VJ E T I  Z A  P O Č E T N I K E
Iako u Photoshopu možemo editirati i vektore, 

pa čak i 3D slike, najviše se koristi za obradu 

rasterskih slika. Pixel je točkica koja čini 

osnovnu jedinicu slike u rasteru.  Raster je 

način organiziranja i prikazivanja digitalne 

slike putem mreže točkica, odnosno piksela. 

Rasterizacija je proces konverzije vizualnog 

sadržaja u elemente nazvane pikseli, koji 

čine matricu u obliku redova i stupaca. Svaki 

piksel može imati svoju boju i svjetlinu, čime 

se zajedno stvara cjelokupna slika. Broj piksela 

po visini i širini slike je dimenzija slike, dok 

broj piksela po jedinici duljine (obično po inču) 

definira rezoluciju slike što još možda nazvati 

gustoća slika kao bi bolje shvatili o čemu je riječ. 

Veća rezolucija znači više piksela po jedinici 

inča i općenito bolju kvalitetu slike. Slika tad 

ima veću gustoću točkica pa su tako točkice 

sitnije i manje vidljive, a prijelazi između boja 

su kvalitetniji. Rezolucija monitora je 72/dpi 

(dots per inch) pa zato slike koje prikazujemo 

na monitorima i mobitelima ne trebaju biti 

visoke kvalitete da bi dobro izgledale, dok slike 

koje želimo otisnuti moraju biti preko 200 dpi, 

a poželjno 300 dpi.

Rasterske slike/fotografije mogu biti 

pohranjene u različitim formatima kao što 

su JPEG, PNG, TIFF i drugi. Svaki format ima 

svoje prednosti i nedostatke u smislu kvalitete, 

kompresije i podržanih značajki. Photoshop 

može raditi sa svim gore navedenim 

formatima slike, ali njegov matični format je 

PSD i on sadrži sve što smo u njemu napravili 

u odvojenim slojevima pa kad ga otvorimo 

možemo nastaviti obradu tamo gdje smo stali. 

Zato su ti formati i puno teži (na disku) jer 

sadrže puno više informacija i detalja o slici 

nego komprimirani formati kao što su JPEG ili 

PNG.

Promjena veličine rasterske slike može dovesti 

do gubitka kvalitete ako se slika povećava 

(pixellization) ili do previše glatkog izgleda 

ako se slika smanjuje (blur) jer Photoshop 

sam kalkulira i dodaje ili oduzima piksele 

prilikom promjene veličine. Iako danas to radi 

bolje nego prije 10 ili 20 godina i dalje je bolje 

kada ne diramo dimenziju/rezoluciju previše. 

Rasterske slike su dakle odlične za realistične 

P o m i c a n j e
Osnovni alat kojem se uvijek vraćamo je Move 

alat za pomicanje. Nalazi se na vrhu alatne 

trake, a kratica za njega je slovo V. Move alat 

je postao vrlo intuitivan pa klikom na dio 

slike on bira sloj koji je osjetio da se nalazi na 

tom mjestu pa pazite kad pomičete slojeve da 

pomaknete onaj koji stvarno želite pomaknuti.

U n d o
Jedan od najčešćih postupaka koje ćete raditi 

i ponavljati je UNDO. Ako napravite grešku ili 

želite otići par koraka unazad  koristit ćete 

izbornik Edit/Undo ili CTRL+Z. Na taj način 

pomičete se jedan korak unazad kroz vašu 

povijest editiranja. 

h i s t o ry
Ako želimo bolje upravljati našom povijesti 

editiranje koristi ćemo paletu History gdje 

možemo vidjeti zadnjih 20 koraka koji smo 

napravili i na vrhu našu početnu sliku kako 

je izgledala nakon otvaranja. Ako vam History 

palate nije otvorena, možete ju naći u izborniku 

Window gdje se nalaze sve palete.

Z O O M  i  s n a l a ž e n j e
Savladavanje brzog približavanja detalja 

na slici ili udaljavanja je presudno za brzi 

rad. Kratica za Zoom alat je Z i tad se kursor 

pretvara u povećalo s plusićem u sredini. 

Klikanjem po slici približavamo detalje 

slike, a kao se želimo udaljiti držat ćemo 

tipku ALT i tad dobijemo minus u sredini 

povećala. U naslovnoj traci Zoom alat vidimo  

opciju		          i dok je ona uključena 

možemo kliknuti i vući zoom alat za glatke 

prijelaze. Ako je ta opcija isključena, tad sa 

Zoom alatom možemo označiti točno određeni 

dio koji želimo uvećati. Korisne su nam tu i 

kratice CTRL + 0 kako bi u sekundi vidjeli cijelu 

sliku na ekranu, dok CTRL + 1 nam prikazuje 

sliku na 100% uvećanja. Dok se služimo drugim 

alatima najzgodnije je koristiti kratice za 

uvećanje ili CTRL + “+” ili za udaljavanje CTRL 

+ “-” dok za dodatno snalaženje i pomicanje po 

samom kanvasu koristimo tipku SPACE.

d u p l i c i r a n j e
Ponekad ćete imati potrebu duplicirati 

neki sloj na vašoj slici. Jedan od načina da 

to napravimo je tako da kliknemo na sloj 

koji želimo duplicirati i odvučemo ga na 

ikonu   	  novog sloja u Layers paleti. Drugi 

još jednostavniji način je da izaberemo Move 

alat s tipkom V i kliknemo na dio slike koji 

želimo duplicirati. Zatim stisnemo tipku ALT i 

povučemo dio slike Move alatom.

U R E Đ I VA N J E  S E L E KC I J E
Selekcija u Photoshopu se odnosi na proces 

odabira određenih dijelova slike za primjenu 

različitih efekata, prilagodbi ili manipulacija 

uz pomoć raznih alata za izradu selekcija. Kada 

napravite selekciju, bilo koji efekti ili promjene 

koje primijenite utjecat će samo na odabrane 

dijelove slike i sloj na kojem se nalazite, a ostatak 

će ostati nepromijenjen. Ako želite pomaknuti 

selekciju na drugo mjesto na slici, morate biti 

na nekom od alata za selekciju, kao npr. Lasso ili 

Marquee i pozicionirani unutar selekcije. S Move 

alatom nije moguće pomaknuti samo selekciju jer 

s njim mičemo i piksele slike koji se nalaze unutar 

označenog dijela. Za transformaciju selekcije isto 

nije moguće koristiti običan Transform alat ili 

CTRL + T jer ćemo isto izrezati dijelove slike kao 

i s Move alatom. Za transformaciju samo selekcije 

idemo na izbornik Select > Transform Selection.

s u č e l j e
Izgled sučelja u Photoshopu biramo pod 

izbornikom Window > Workspace, ovisno za što 

koristimo program, a moguće je prilagoditi sučelje 

i našim potrebama pa spremiti postavke  u istom 

tom izborniku. S tipkom F se možemo prebacivati 

u Full Screen i izaći iz njega, a sa tipkom TAB 

možemo se prebacivati između otvorenih slika. 

Ravnala možemo uključiti tipkom R, a klikom i 

povlačenjem iz ravnala možemo izvući vodilice. 

Izbornikom View > Show... možemo paliti i gasiti 

vidljivost vodilica, ako i kraticom CTRL + H. U tom 

istom izborniku možemo upaliti i mrežu (Grid) 

kako bi si olakšali slaganje objekata na kanvasu. 

Desnim klikom na ravnalo možemo po potrebi 

promijeniti mjerne jedinice.

slike i fotografije, ali mogu imati ograničenja 

u vezi sa skaliranjem i manipulacijom 

bez gubitka kvalitete. Suprotno rasteru, 

vektorska grafika se temelji na matematičkim 

proračunima i definicijama oblika, što 

omogućava beskonačno skaliranje bez gubitka 

kvalitete. Zato se oblici koje znamo da ćemo 

trebati povećavati kao npr. Logo firme rade u 

vektoru i editiraju u programima za obradu 

vektora kao što je Ilustrator.

Veličinu rasterske slike možemo promjeriti u 

padajućem izborniku Image/Image Size gdje 

možemo vidjeti sve postojeće podatke o slici 

– veličina (na disku), dimenzija, rezolucija. 

Pod opcijama Width i Height možemo upisati 

željene dimenzije u različitim mjernim 

jedinicama kao što su Pixels, Centimetri, 

Milimetri, Dots i sl. Ako želimo proporcionalno 

povećati ili smanjiti sliku moramo zaključati 

odnos između visine i širine uz pomoć ikone 

karike lanca koja se nalazi ispred opcije 

Width i Height. Promjenom dimenzija 

automatski utječemo na veličinu slike pa će 

nam Photoshop odmah izračunati i prikazati 

pod File size koliko će biti teška slika nakon 

promjene dimenzija ili rezolucije. Ono što je 

bitno kad govorimo o dimenzijama slike je da 

imamo na umu dvije stvari, a to su:

Fizička dimenzija slike i Digitalna dimenzija 

slike

Fizičku dimenziju mjerimo u centimetrima 

ili milimetrima i ona nam je opipljiva i realna 

te naravno bitna ako sliku šaljemo u tisak ili 

printamo. 10 cm je uvijek 10 cm i tako će ispasti 

na papiru. Rezolucija slika za print smo već 

rekli da je najbolja pri 300 dpi i ona ne utječe 

na dimenziju već na kvalitetu slike te hoće li 

slika biti jasna i oštra ili mutna.

Digitalna dimenzija je ono što vidimo na 

ekranu i prikazujemo ju u pikselima tako kad 

pripremao sliku za recimo Instagram uvijek 

ćemo određivati dimenziju po mjernoj jedinici 

piksela za širinu i visinu slike pa onda kažemo 

da nam je slika dimenzije 1080x1080 px. 

I jedno i drugo su dimenzije slike samo 

prikazane u drugim mjernim jedinicama 

ovisno i onome što radimo i za što nam ta 

slika bude služila – print ili ekran. Za bolje 

• DIMENZIJA SLIKE U CM
• DIMENZIJA SLIKE U PX
• DIMENZIJA DATOTEKE
• REZOLUCIJA
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R O TA C I J A  K A N VA S A
Tipkom R možemo uključiti opciju rotacije 

kanvasa, a ako držimo SHIFT zakretat ćemo 

sliku u koracima po 15° Osim ove opcije 

orijentaciju kanvasa možemo promijeniti u 

izborniku Image > Image Rotation.

I M A G E  I  C A N VA S  S I Z E
U izborniku Image imamo opcije promjene 

veličine slike ili veličine samog kanvasa 

slike. Cnavas SIze proširuje sliku u 

izabranoj Background boji i u smjeru 

koji izaberemo. Image Size nam pruža 

povećavanje i smanjivanje naše slike, 

te promjenu rezolucije slike. Pritom je 

potrebno napomenuti da velike promjene na 

dimenzijama slike i njezinoj rezoluciji mogu 

dovesti do neželjenog efekta zamućivanja 

slika pa s tim opcijama trebate postupati 

pažljivo, pogotovo na početku dok još učite.

P O R AV N AVA N J E 
Ako imam više nacrtanih objekata u 

različitim slojevima, ponekad će nam 

zatrebati poravnavanje tih slojeva. Da bi 

to bilo moguće prvo moramo označiti više 

slojeva odjednom tako da kliknemo na 

prvi sloj pa držeći pritisnutu tipku SHIFT 

kliknemo na drugi sloj, pa treći sloj i tako 

ponavljamo dok ne označimo sve slojeve 

koje želimo označiti. Sada kada imamo više 

slojeva označenih u Kontrolnoj traci će se 

vidjeti opcije za poravnavanje ili Align...

Ikonice nam već same pokazuju po kojoj liniji 

će poravnati elemente slojeva pa da bi naučili 

koristiti tu opciju najbolje je malo se poigrati. Nije 

uopće teško, a vjerujem da ste se već sa sličnim 

opcijama susreli i u drugim programima. 

c r o p
Višak kanvasa možemo odrezati u Image > 

Canvas size ili više prostoručno uz alat Crop. U 

kontrolnoj traci možemo birati omjer slike ili 

unijeti svoj omjer te uz pomoć Straighten opcije 

poravnati horizont. Corp okvir mičemo kao i 

Transform alat. 
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Kratice u Photoshopu su jako bitne jer 
povećavaju produktivnost te smanjuju napor 
i vrijeme rada. Pokušajte ih što prije naučiti 
napamet kako bi ubrzali svoj proces rada.

informacija nije promijenila. U svakom slučaju 

ova slika s većom rezolucijom će isprati oštrija 

kada se otisne nego ova s manjom rezolucijom. 

Uglavnom taj dio oko dimezija i rezolucije je 

svima dosta teško za shvatiti, ali s dolaskom 

novih generacija Photoshopa i AI mislim da 

uskoro neće ni biti toliko bitno jer će se slike 

moći puno bolje povećavati ili izoštriti bez 

brige o pikselima i dimenzijama te njihovom 

omjeru. Sad kad smo to shvatili možemo 

krenuti na alate i samu obradu. U sljedećem 

poglavlju ćemo vidjeti sučelje, nabrojati alate 

i kratice, a svaki alat ćemo zapravo detaljnije 

proći prilikom obrade određenog poglavlja.

razumijevanje vidi sliku desno >

U istom tom okviru imamo prozor za promjenu 

rezolucije koja može biti ovisna o dimenzijama 

ili neovisna. Što to znači? To znači da možemo 

promijeniti gustoću odnosno količinu piksela 

na slici bez promjene dimenzija ili tako da 

promijenimo i dimenziju slike. Ako dimenzije 

slike ostaju iste, a promijenimo rezoluciju sa 

100 na 300, tad Photoshop na svaki piksel dodaje 

nove piksele i dolazi do promjene na kvaliteti 

slike, ovisno koliko dobro Photoshop obavi 

taj posao. Druga opcija je ako imamo fizički 

veliku sliku s malom rezolucijom, mi možemo 

preokrenuti stvari tako da uopće ne dodajemo 

novih piksela na sliku već da sliku fizički 

smanjimo te istovremeno zapravo povećamo 

količinu piksela po inču. Dakle recimo slika od 

1000x1000 px i 100 dpi, prebacimo piksele da 

ih ima više - znači 300 pdi, ali zato je postala 

manja fizička dimenzije 333x333 px. Za bolje 

razumijevanje vidi primjer ispod, imamo sliku 

koja je 60x60 cm dimenzija, ali ima samo 100 

dpi rezoluciju. Ako ju želimo otisnuti potrebna 

nam je veća rezolucija. Napravit ćemo sljedeće: 

isključiti opciju Resample te pod Resolution 

upisati 300. Primijetite što se dogodilo na 

donjoj slici - ona je sada 20x20 cm, dok se Image 

Size nije promijenio jer se zapravo količina 

Ovo je početna slika 

dimenzija 60x60 cm i 100 

dpi rezolucije, a veličina 

datoteke je 16 mb. 

Donja slika nakon promjene 

rezolucije je automatski smanjila 

fizičku dimenziju  na 20x20 cm, dok 

je veličina datoteke ostala i dalje 

ista, 16mb.

k r at i c e

Move / Artboard tool	 V
Rectangular / Elliptical Marquee tool	 M
Lasso / Polygonal / Magnetic Lasso tool	 L
Object / Quick Selection tool	

W
Magic Wand tool	
Crop/ Perspective Crop tool	

C
Slice/ Slice Select tool	
Eyedropper / Color Sampler tool	

I
Ruler/Note tool	
Frame tool	 K
Spot Healing Brush tool	

J
Healing Brush tool	
Patch tool	
Red Eye tool	
Content-Aware Move tool	
Red Eye tool	
Brush tool	

B
Pencil tool	
Color Replacement tool	
Mixer Brush tool	
Clone Stamp tool	

S
Pattern Stamp tool	
History Brush tool	

Y
Art History Brush tool	
Eraser tool	

EBackground Eraser tool	
Magic Eraser tool	
Gradient tool	

GPaint Bucket tool	
3D Material Drop tool	
Dodge / Burn / Sponge tool	 O
Pen tool	

PFreeform Pen tool	
Curvature Pen tool	
Horizontal Type tool	

T
Vertical Type tool	
Horizontal Type mask tool	
Vertical Type mask tool	
Path Selection tool	

A
Direct Selection tool	
Rectangle / Ellipse / Polygon tool	

ULine tool	
Custom Shape tool	
Hand tool	 H
Rotate View tool	 R
Zoom tool	 Z

Otvori sliku	 CTRL (CMD) + O
Spremi sliku	 CTRL (CMD) + S
Zatvori sliku	 CTRL (CMD) + W
Ravnala	 CTRL (CMD) + R
Navigacija kroz tabove	 TAB
Hand alat	 SPACE
F/B boje u crno/bijelo	 D
Zamjena F/B boja	 X
Undo	 CTRL (CMD) + Z
Copy	 CTRL (CMD) + C
Paste 	 CTRL (CMD) + V
Paste in Place	 CTRL (CMD) + SHIFT + V
Transformiraj	 CTRL (CMD) + T
Novi prazni sloj	 CTRL (CMD) + N
Kopiraj u novi sloj	 CTRL (CMD) + J
Izreži u novi sloj	 Shift + CTRL (CMD) + J
Dodaj u selekciju	 Slection tool + SHIFT 
Označi sve	 CRTL + A
Odznači sve	 CTRL (CMD) + D
Inverzna selekcija	 CTRL+SHIFT+I
Standard and Quick Mask mode	 Q
Fit in screen	 CTRL + 0
Uvečanje 100%	 CTRL + 1
Image SIze	 CTRL (CMD) + ALT + I
Canvas Size	 CTRL (CMD) + ALT + C
Zoom in	 CTRL (CMD) +  +
Zoom out	 CTRL (CMD) +  - 
Fill Foreground Color	 ALT + DEL
Fill Background Color	 CTRL (CMD) + DEL

OZNAČAVANJE VIŠE SLOJEVA	 Pritisni i drži SHIFT + KLIK NA SLOJ
CRTAJ RAVNU LINIJU S BRUSH ALATOM	 Pritisni i drži SHIFT + KLIK 
CRTAJ RAVNU LINIJU S LINE ALATOM	 Pritisni i drži SHIFT + KLIK + VUCI

Kratice su unaprijed definirane 
kombinacije tipki koje izazivaju određenu 
akciju. Ako želite promijeniti ili prilagoditi 
kratice sebi i svom radu, slijedite ove 
korake, uz napomenu da se ovi koraci mogu 
razlikovati ovisno o verziji Photoshopa u 
kojoj radite.

1. Otvorite izbornik “Edit” (Uredi) i 
odaberite opciju “Keyboard Shortcuts” 
(CTRL + SHIFT + ALT + K).
2. Prije izmjene kratica potrebno je 
napraviti novi set klikom na ovaj gumb, 
spremimo ga pod svojim imenom.

3. Pronađite akciju za koju želite 
promijeniti kratice i kliknite na trenutnu 
kombinaciju tipki koja je dodijeljena toj 
akciji.
4. Unesite željene nove kratice. Pazite 
da ne koristite kratice koje već postoje u 
drugim funkcijama Photoshopa kako biste 
izbjegli konflikte.
5. Nakon izmjene spremite promjene i 
isprobajte kratice radom u Photoshopu 
kako bi bili sigurni da funkcioniraju.

p r o m j e n a
k r at i c a
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S L O J E V I
( l ay e r s )

R A D  S 
B O J O M

Sa slojevima upravljamo u Layers paleti i Layers 

izborniku. Razumijevanje slojeva i znanje o njima 

je od krucijalne važnosti za rad u Photoshopu jer 

ćemo se stalno njima koristiti i često se vraćati 

nazad na njih dok budemo napredovali kroz 

ostale opcije koje se međusobno isprepliću.

Ja na slojeve gledam kao papire i prozirne folije 

koje nam pomažu da odvojimo dijelove slike i 

obrađujemo dio po dio bez brige da ćemo uništiti 

originalnu sliku. Također nam služe da odvojene 

dijelove slike možemo pomicati uz pomoć 

kursorskih tipki ili Move alata te im promijeniti 

redoslijed vidljivosti ovisno koji je sloj iznad, 

a koji ispod. Možemo sadržaju promijeniti 

veličinu ili oblik uz pomoć Transform alata ili 

promijeniti svojstva sloja uz neke druge opcije. 

Ovako izgleda proziran sloj ili dio sloja kada se 

ništa ne nalazi ispod njega:

Kad otvorimo sliku prvi i jedini sloj u paleti će 

biti Background sloj. Nove prazne (prozirne) 

slojeve stvaramo klikom na ikonu OVU pa na 

tom sloju možemo crtati i utjecati na sliku 

bez da utječemo na piksele same slike. Kako 

znamo da je to što smo nacrtali u posebnom 

sloju? Moramo označiti taj sloj klikom na njega, 

a nakon crtanja provjeriti tako da ugasimo 

vidljivost sloja klikom na ikonu oka          Razne 

nove slojeve stvaramo i kad pišemo tekst uz 

pomoć Text alata, kad ubacimo novu sliku na 

postojeću s opcijom Place/ drag&drop ili kad dio 

slike kopiramo i zalijepimo s kraticom CRTL+C/

CTRL+V ili još brže samo sa CTRL+J.

Slojeve možemo premještati, odnosno 

promijeniti im redoslijed drag&drop opcijom – 

tako da kliknemo i povučemo sloj iznad ili ispod 

drugog sloja (naravno ne i ispod Background 

sloja, on je uvijek ispod svih slojeva sve dok ga 

ne preimenujemo duplim klikom na sloj – tad 

postaje običan sloj i možemo ga premještati). 

Na isti način (duplim klikom na sloj) možemo 

mijenjati ime bilo kojeg sloja. Ukoliko želite 

Na slici vidimo stilizirani 

prikaz slojeva i kako ti slojevi 

izgledaju u Layers paleti.

Boja je važan dio slike pa ćemo o noj govoriti 

puno i dosta se vračati na tu temu. U 

Photoshopu ima puno opcija za korištenje i 

manipuliranje bojom, navest ćemo neke od njih 

te pokazati primjerom za što se koriste i na koji 

način. 

Color panel nam koristi za 

traženje i definiranje boja 

koje možemo koristiti kao 

Foreground ili Background 

boju – iste one boje koje 

nalazimo na dnu alatne trake. 

Ovisno na koju od njih kliknemo, tu boju 

mijenjamo. Klizanjem po desnom klizaću u 

spektru duginih boja biramo boju, a klikom na 

dio kvadrata biramo ton boje. 

U opcijama palete možemo birati vrstu prikaza 

boje i detaljnije ju definirati pomicanjem recimo 

RGB klizača kao na ovoj slici desno. RGB boje 

koristimo kada pripremamo slike za pregled na 

ekranu dok CMYK boje biramo za tisak. Kako 

bi saznali u kojem modu je uopće slika na kojoj 

radimo te eventualno promijenimo mode boja 

cijele slike – to radimo izborom na izbornik 

Image > Mode.

Color paleta nije jedini način da izaberemo boju 

– možemo je izabrati i klikom na Foreground 

ili Background boju pa ćemo dobiti sličan Color 

picker. Nakon što smo izabrali boju koja nam 

odgovara, tu boju možemo spremiti i za kasnije 

korištenje klikom na gumb Add to Swatches u 

Swatches paletu.

Swatches paleta nam služi kako bi mogli 

izabrati neke već definirane boje ili spremiti 

svoje boje za kasnije korištenje. Kada smo 

spremili boje i izabrali koje ćemo koristiti, 

možemo Foreground boju s Background bojom 

na brzinu zamjeriti uz pomoć opcije Toggle, 

odnosno kraticom na tipkovnici X.

Kad želimo vratiti boje na početne postavke, 

tj na bijelu i crnu, kliknemo na bijelo/crni 

kvadratić iznad F/B boja ili kraticom na 

tipkovnici slovo D. To je nešto što ćemo vrlo 

često koristiti pa je najbolje zapamtiti kratice X 

i D za brže snalaženje i korištenje.

Ako imamo potrebu uzeti neku već postojeću 

boju s naše slike tad nam dobro dođe Eyedropper 

alat u alatnoj traci ili ga biramo kraticom pod 

slovom I. Klikom na dio slike gdje se nalazi 

željena boja biramo boju za Foreground boju, a 

ako želimo izabrati Background boju potrebno 

je držati tipku ALT. 

Osim toga imamo i Gradient alat i paletu za 

staranje i spremanje raznih prijelaza između 

boja, a u naslovnoj traci možemo birati već 

spremljene gradijente te i njegov oblik.

odjednom selektirati/označiti više slojeva, 

potreban je CTRL+lijevi klik miša na željene 

slojeve. Slojeve možemo i spajati biranjem opcija 

Flaten, Merge Visible ili Merge Down desnim 

klikom na sloj. 

Ako želimo sloj napraviti poluprozirnim, to 

radimo opcijom Opacity pri vrhu Layers palete. 

Ako želimo gornji sloj stopiti s donjim slojem, to 

postižemo s Blend mode opcijom lijevo od Opacity 

– vidjet ćemo da tu imamo više opcija kao što su 

Multiply, Darken, Burn, Soft Light... svaka opcija 

stapa sloj na različiti način utječući na određeni 

ton, boju ili svjetlinu slike pa da bi dobili željeno 

stapanje trebamo se poigrati i isprobavati. 

Sloj možemo obrisati klikom na ikonu OVU ili 

s Delete. Ako ne želimo slučajno pomaknuti ili 

obrisati dio nekog sloja, tad ga zaključamo uz 

pomoć ovih opcija 			   Kada 

želimo da se gornji sloj poveže s donjim slojem 

i samo na njega utječe, to radimo sa desnim 

klikom na sloj i biramo Link Layers (ALT + klik 

između dva sloja). Slojeve možemo i grupirati 

radi bolje preglednosti klikom na OVU ikonu.

S Photoshopom možete postići razne efekte i 
kombinirati boje i gradijente kako biste stvorili 
željeni izgled za svoje slike ili grafike. Kao i za 
sve u životu važno je eksperimentirati i vježbati 
kako biste postali bolji u upotrebi tih alata.

s avj e t  v i š e



Kada radimo sa slikama 
bit će situacija kada 

ćemo trebati deformirati 
određene dijelove slike 

ili čak i cijelu sliku... 
preokrenuti, zarotirati, 

smanijit ili nakositi!

Uz pomoć selekcija 
najlakše editiramo 
samo određeni dio 
piksela, dok sve oko 
selekcije je zaštičeno 
od obrade...

Transformacija u Adobe Photoshopu se 

odnosi na proces mijenjanja veličine, rotacije, 

iskrivljenja ili preokretanja odabranih slojeva, 

selekcija ili cijele slike. Ovo je ključni alat za 

uređivanje i prilagodbu elemenata vašem 

dizajnu. Transformacija vam omogućava 

precizno upravljanje veličinom, pozicijom 

i orijentacijom elemenata čime postižemo 

željeni izgled ili kompoziciju.

Kao što smo već spomenuli u radu sa selekcijama, 

Transform alat nije dobra opcija jer na taj način 

režemo piksele koji se nalaze u selekciji. Kako bi 

transformirali samo selekciju koristimo izbornik 

Select > Transform Selection. 

Ako želimo našu sliku prebaciti iz Landscape 

u Portret, tada koristimo izbornik Image > 

Image Rotation. Tu su nam opcije zakretanja 

slike u smjeru kazaljke na sati ili obrnuto, te 

zaokret za 180°. Osim toga imamo opciju Flip po 

vertikalnoj ili horizontalnoj osi.

Osim gore navedenog možemo transformirati 

i svaki element na slici koji je odvojen u svoj 

sloj (Layer). Za transformaciju sloja koristimo 

izbornik Edit > Transform ili Free Transform 

koji također možemo pokrenuti i s kraticom 

CTRL + T. S opcijom Transform biramo pojedino 

vrstu transformacije i radimo samo nju. Na 

primjer, ako izaberemo Rotate, samo možemo 

zarotirati objekt, ništa drugo. Ne možemo ga 

smanjiti ili nakositi jer za te opcije moramo 

izabrati drugu vrstu transformacije. Ako želimo 

više vrsta transformacije izvesti istovremeno, 

za to nam je puno bolja opcija Free Transform 

Tool koju ja osobno puno više koristim nego 

alate ili opcije transformacije koje su zasebne.

Kada aktiviramo Free Transform opciju na 

određenom sloju, vidjet ćemo da se oko objekta 

stvari okvir s 8 točaka (kockica) na okviru. 4 

na kutovima okvira i 4 na sredini linija okvira. 

To su točke koje koristimo da bi manipulirali 

s objektom na razne načine. Kako prelazimo 

s kursorom miša preko pojedine točke, 

izgled kursora se mijenja i na taj način nas 

Photoshop obavještava što s pojedinom točkom 

možemo napraviti (vidi sliku iznad). S kutnim 

točkama skaliramo objekt, a ako se kursorom 

pomaknemo malo izvan kutne točke dobijemo 

zakrivljenu strelicu za rotaciju objekta. 

Rotaciju vršimo iz središta, ali ako želimo 

možemo središte rotacije pomaknuti gdje nam 

treba. Rotaciju možemo vršiti i u koracima 

od 15° tako da držimo pritisnutu tipku SHIFT. 

S točkama na stranicama iskrivljujemo i 

skaliramo objekt po cijeloj osi stranice. Ako 

želimo prilikom skaliranja zadržati proporcije 

objekta potrebno je držati tipku SHIFT, a 

ako želim skalirati iz centra objekta držimo 

tipku ALT. Tipke se naravno mogu koristiti 

istovremeno. Ako želimo samo jednu kutnu 

točku pomaknuti/iskriviti (Distort) prilikom 

micanja točke potrebno je držati tipku CTRL 

(CMD). Kada želimo samo jednu stranicu 

nakositi, prilikom pomicanja središnje točke 

držimo CTRL (CMD).
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Rad sa selekcijama nam uveliko olakšava 

editiranje slika u Photoshopu jer nam 

omogućava biranje točno određenog dijela 

slike na koji ćemo utjecati s raznim izmjenama, 

bilo da je promjena boje, dodavanje gradijenta, 

brisanje, rezanje, kopiranje ili apliciranje 

filtera. Napravit ćemo kratki pregled alata koje 

možemo koristiti za izradu selekcija.

Prvi od alata s koima se susrećemo su Marquee 

alati - Rectangular, Elipse, te Single Row i 

Single Column.

Kako bi došli do svih alata koji se nalaze ispod 

u grupi potrebno je kliknuti na alat i držati 

stisnutu tipku miša. Za iscrtavanje selekcije 

dovoljno je kliknuti i vući miš u željenom 

smjeru. Selekciju prepoznajemo po iscrtkanoj 

liniji koja djeluje kao da se pomiče. Ako želimo 

pravilan krug i kvadar potrebno je prilikom 

povlačenja miša držati stisnutu tipku SHIFT, 

a ako pritom želimo crtati iz sredine selekciju, 

potrebna je tipka ALT.

Kada imamo selekciju, možemo je micati dok 

god smo na nekom od Marquee alata, tako de 

se pozicioniramo unutar selekcije - Primijetite 

da se kursor pretvorio u bijelu strelicu - sada 

je moguće pomaknuti selekciju. Ako slučajno 

kliknemo s mišem pokraj selekcije, selekcija 

će nam nestati, zato trebamo paziti što i kako 

radimo. Napravljenu selekciju možemo doraditi 

tako da dodajemo ili oduzimamo dijelove 

selekcije - za dodavanje selekcije držimo tipku 

SHIFT, a za oduzimanje od selekcije držimo 

tipku ALT. Ako vam selekcija više nije potrebna 

dovoljno je pritisnuti kraticu CTRL + D da sve 

deselektiramo. Sljedeći alati  za selekciju sunam 

alati grupe Lasso.

Lasso alat nam omogućava prostoručno crtanje 

selekcije kao da crtamo olovkom. Polygon Lasso 

je definitivno najkorisnini iz ove dvije grupe alata 

i često ga koristimo jer nam omogućava dosta 

slobodno, a opet precizno iscrtavanje selekcije 

jer radi na principu stvaranja linija od jedne do 

druge točke gdje kliknemo. Ako držim stisnutu 

tipku SHIFT prilikom iscrtavanja selekcije 

moći ćemo povući linije samo pod određenim 

kutem. Zadnji u grupi je Magnetic Lasso alat i 

koristan je kada imamo objekt koji je druge boje 

ili tonaliteta od pozadine pa s njim iscrtavamo 

selekciju prelazeći blizu ruba, a Photoshop sam 

ljepi magnet na liniju razdvajanja koju on sam 

procjeni. Zadnji od ovih alata je Magic Wand. 

Sam naziv nam govori da se radi o nekakvom 

čarobnom štapići s kojim kliknemo na dio koji 

želimo selektirati, a Photoshop označi sve slične 

boje koje se dodiruju na mjestu klikanja i oko 

nje. Koliki dio će nam Photoshop označiti ovisi o 

opciji Tolerance u Kontrolnoj traci, jer što je veći 

broj upisan to će više tonova iste boje izabrati u 

selekciju. Kad radimo kompleksne selekcije dobro 

nam dođe opcija spremanja selekcije u izborniku 

Select > Save Selection, a kasnije kad nam opet 

zatreba idemo na Select > Load Selection. Ako 

imamo sloj sa crtežom koji ima praznih piksela 

oko sebe, najbrži način da selektiramo pune 

piksele je CRTL i klik na sloj.

p o t o s h o p  s a  s va ko m  n o v o m  v e z i j o m  p o s ta j e  s v e  j e d n o s tav n i j i  z a  ko r i š t e n j e 
pa  ta ko  s a d a  i m a m o  o v e  o p c i j e  ko j e  n a m  m o g u  j a ko  o l a kš at i  o z n a č ava n j e 
o b j e k ata  i  u b r z at i  r a d.  o s i m  t o g a  d o l a z e  n a m  n e k e  a i  o p c i j e  pa  i h  s va k a ko 
i s p r o b a j t e  a ko  i m at e  p r i l i ku.  i g r a n j e  i  i s p r o b ava n j e  j e  s a s tav n i  d i o  u č e n j a !

Transformacije 
u Photosopu 
nam nude mnoge 
mogućnosti 
prilagodbe 
sadržaja slika. 
Omogućava nam 
puno kreativnih 
manipulacija 
pa slobodno 
eksperimentirajte 
kako biste postigli 
željeni izgled. 
Svakako koristite 
kratice da si 
olakšate i ubrzate 
manipulaciju 
objekata. Nakon što 
ste izvršili željene 
transformacije, 
pritisnite Enter 
ili dvostruki klik 
unutar okvira s 
transformacijom 
kako biste potvrdili 
promjene. 

s avj e t
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brisanje i 
maskiranje

Kistovi se koriste za razne 
kreatvine procese u 
Photoshopu, kao što je crtanje, 
bojanje, brisanje, te za stvaranje 
tekstura i maski

Brush alat aktiviramo tipkom B, a izgled 

kistova možemo vidjeti u kontrolnoj traci ili 

u paletama Brush i Brush Settings koje se 

nalaze u izborniku Window. Ove dvije palete su 

međusobno povezane što ćete vidjeti kada budete 

birali kistove. Photoshop dolazi s mnoštvom 

već definiranih kistova koje možete koristiti 

za svoje kreativne projekte. Kako bi izabrali 

neki kist jednostavno kliknite na onaj kist koji 

vam odgovara, bilo u paleti ili kontrolnoj traci, 

svejedno je. Kada izaberete kist, kursor miša 

se mijenja u oblik i veličinu kista prikazujući 

krug, elipsu ili drugačiji oblik kista, ovisno koji 

ste izabrali. To vam daje dobar vizualni prikaz 

što ćete koristiti na vašem kanvasu i kako će to 

izgledati. Ako slučajno ne vidite oblik kista nego 

križić, provjerite je l’ vam uključen Caps Lock 

i isključite ga da bi vidjeli izabrani oblik kista. 

Većinu kistova koje izaberemo možemo 

prilagoditi svojim potrebama, povećati, smanjiti, 

omekšati i sl. TO možemo raditi u paletama što 

je zgodno kada želimo baš raditi nove kistove, ali 

dok koristimo gotove kistove mogle bi vam palete 

smetati pa je u tom slučaju jednostavnije koristiti 

opcije iz kontrolne trake ili desni klik miša dok 

koristite Brush alat otvara vam sve postavke 

kista. Ono najbitnije što ćete najčešće koristiti su: 

veličina kista prikazana u pikselima, mekoća kista 

ili Hardness te prozirnost kista ili Opacity. Ono 

što vam može biti korisno je tipka ALT jer kada ju 

imamo pritisnutu i pomičemo kursor gore/dolje, 

mijenjamo veličinu kista, a kad pomičemo kursor 

lijevo/desno mijenjamo mekoću kista. 

Primjer različitih kistova i 

njihovih osobina kao što su 

veličina, mekoća, prozirnost...

Kada je maska bijela sve je na 

slici i dalje vidljivo

Kada je maska crna, ništa na 

slici više nije vidljivo

Sada vidimo da možemo crtati po 

maskiranom dijelu sloja i na taj 

način sakrivati ili otkrivati dijelove 

slike prema potrebi. Crna boja 

skriva, bijela otkriva, anijanse sive 

daju poluprozirni sloj.

20 px           40 px 	         80 px

100% Hardness

Kyle˘s Concept Brushes - Special Efect

Kyle˘s Concept Brushes - Wet Media

Kyle˘s Concept Brushes - Dry Media

50% Hardness

0% Hardness

Kistovi su mogu 
koristiti kao i kad 
crtamo pravim 
kistom ili olovkom, 
prostoručno, ali 
kada želimo dobiti 
ravnu liniju, pomoći 
će nam tipka SHIFT. 
Možemo ju držati 
dok crtamo, a 
možemo kliknuti 
gdje želim da je 
početna točka, 
zatim pritisnemo 
tipku SHIFT i 
kliknemo na 
mjesto gdje želimo 
da bude završna 
točka. Photoshop će 
spojiti te dvije točke 
ravnom linijom u 
debljini i izgledu 
izabranog kista.

Maska može 
i djelomično 
prikazivati piksele 
sloja na kojem se 
nalazi, a to možemo 
postići tako da 
crtamo po maski 
s nekom nijansom 
sive boje. Što je siva 
tamnija prozirnost 
će biti veća, 
odnosno svjetlija 
siva će imati manju 
prozirnost.

s avj e t
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b r ž i  n a č i n  z a  d o d j e l i t i  m a s ku  i z a b r a n o m  s l o j u  j e  u z  p o m o ć  g u m b a        
n a  d n u  l ay e r s  pa l e t e .  k l i ko m  n a  ta j  g u m b  d o d b i va m o  b i j e l u  m a s ku,  d o k 
s a  a lt + k l i k  n a  g u m b  d o b i va m o  c r n u  m a s ku. 

a ko  p r i l i ko m  p r i t i s k a  g u m b a  i m a m o  n e ku  s e l e kc i j u  n a  s l i c i ,  d o b i t  ć e m o 
c r n u  ( p r o z i r n u )  m a s ku  n a  m j e s t u  g d j e  n i j e  b i l o  s e l e kc i j e ,  a  b i j e l u 
( n e p r o z i r n u )  n a  m j e s t u  g d j e  j e  b i l a  s e l e kc i j a .  a ko  ž e l i m o  o b r n u t u 
m a s ku,  d r ž i m o  t i p ku  a lt  p r i l i ko m  p r i t i s k a  g u m b a .

n a  ta j  n a č i n  v i d i m o  d a  n a  r a z n e  n a č i n e  m o ž e m o  k r e i r at i  m a s k e ,  a 
d o d at n o  j u  m o ž e m o  d o r a D i t i  u z  p o m o ć  p r o p e r t i e s  pa l e t e . . .

U Photoshopu postaje razni 
načini kako možemo obristi 
dio slike... recimo možemo 
uz pomoć selekcija, Eraser 

alata ili uz pomoć maski

Ako se niste do sad koristili Photoshopom, neki 

od ovih koncepata bi vam mogli biti potpuno 

nepoznati, ali uz primjere i vježbu ih nije problem 

savladati.

Eraser alat ima ikonicu gumice i otvaramo ga 

uz kraticu E na tipkovnici. U principu on i radi 

kao gumica, baš fizički uklanja piksele sa sloja 

na kojem se nalazimo - osim ako se nalazimo na 

Background sloju - on je zaključan pa ne možemo 

obrisati piksele. U tom slučaju Eraser alat 

preslikava dijelove slike s izabranom Background 

bojom. Iako je to koristan alat i stvarno ponekad 

imamo potrebu obrisati nešto na slici, koristimo 

ga umjereno jer piksele koje obrišemo naknadno 

više ne možemo vratiti nazad, oni su nepovratno 

uništeni. Postoji i bolja solucija u Photoshopu, 

manje destruktivna metoda, a to je maskiranje 

slojeva (Layer Mask).

Maskiranje slojeva je pametan način za brisanje 

dijelova slike bez da uništimo sliku koja se nalazi 

ispod. Maske, umjesto fizičkog brisanja piksela 

slike, rade na principu da sakrivaju dijelove slike 

koje ne želimo vidjeti, a opet uvijek im se možemo 

vratiti s obzirom da nisu nestali, nisu nepovratno 

uništeni.

Najbolji način za shvatiti maske je da ih 

usporedimo sa onim “srećkama grebalicama” 

koje imaju film preko slike. Kada taj film na 

dijelu sastružemo, ispod se vidi slika. Slično je i sa 

maskiranimo slojem.

Pa krenimo sa isprobavanje jer tako ćete najbolje 

savladati maske. Da bi dodali masku na sloj 

koristimo izbornik Layers > Layer Mask . Vidjet 

ćemo da imamo nekoliko mogućnosti: Reveal All, 

Hide All ili From Transparency. Opcija Reveal All 

će stvoriti masku na sloju koja je bijele boje, a to 

znači da je ta maska potpuno prozirna te se sve na 

tom sloju i dalje vidi. To izgleda ovako:

Ako izaberemo Hide All opciju, maska na sloju će 

biti prikazana u crnoj boji, a sve što se nalazi na 

tom sloju neće više biti vidljivo na našoj slici.

Opcije From Transparency ima smisla koristiti 

samo ako na sloju imam prozirnih dijelova slike. 

Tada maska prikazuje pune piksele slike, a ne 

prikazuje prazne piksele, a to možemo zaključiti 

po izgledu maske i naše slike - maska je crna na 

mjestima oko naših elemenata na sloju, a bijela na 

mjestu gdje se nalaze objekti:

Sada ćemo probati napraviti nešto drugačije, ,cilj 

nam je sakriti krug uz pomoć maske, tako da samo 

ostane vidljiv kvadrat. Koko to postići? Pa ako nam 

bijelo na maski daje vidljivost sloja, a crno skriva 

dijelove sloja, onda ćemo NA MASKI obojati krug 

u crnu boju. Dok radimo na maski, ona mora biti 

označena bijelim okvirom. Uzmimo kist i obojajmo 

masku na mjestu kruga da dobijemo ovo:
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Ako ste možda imali priliku 
susresti s nekim vektorskim 
programima kao Adobe 
Illustrator vjerojatno ste 
vidjeli i koristili Pen alat koji 
funkcionira na isti način i u 
Photoshopu te nam služi za 
stvaranje staza (Paths), ali 
koncept korištenja staza je 
ovdje jedinstven i poseban.

tipkovnici sve što dodatni alati rade možemo postići i 

s osnovnim Pen alatom. 

Crtanje staze Pen alatom zahtjeva malo prakse, ali 

nije ni previše teško. Običnim klikanjem Pen alata 

po slici dodajemo točke koje se automatski spajaju 

ravnim linijama. Ako želimo napraviti krivulju 

moramo kliknuti i vući kursor miša te na taj način 

izvlačimo vodilice iz točke koje onda stvaraju 

krivudavu liniju između točaka. Kada želimo zatvoriti 

stazu u neki oblik potrebno je nakon dodavanja 

željenih točaka ponovno kliknuti na početnu točku 

iz koje smo krenuli crtati oblik. Vidjet ćemo kada se 

pozicioniramo kursorom miša iznad početne točke 

da uz izgled kursora u obliku nalivpera dobivamo i 

mali kružić- - to nam Photoshop javlja da zatvaramo 

liniju i stvaramo oblik. 

Sada kad imamo stvoreni i označeni oblik, s aktiviranim 

Pen alatom, možemo dodati i oduzimati točke tako da 

se pozicioniramo iznad linije gdje želimo dodati točku 

ili iznad točke koju želimo maknuti. To znamo da je 

moguće jer pozicioniranjem kursora iznad linije uz 

nalivpero dobivamo +, a pozicioniranjem iznad točke 

vidimo -.  Ako želimo ravne linije pretvoriti u krivulje 

ili obrnuto, koristimo Convert Point alat. Uz njegovu 

momoć klikom i povlačenjem na običnu točku iz nje 

izvlačimo vodilice i stvaramo krivulje, a klikom na 

točku s vodilicama ih mičemo i ostaje nam obična 

točka iz koje idu ravne linije. Prilikom korištenja Pen 

alata možemo i na brzinu aktivirati i Convert Point 

alat tako da istovremeno pritisnemo CTRL + ALT pa 

Iako Photoshop nije desktop publishing program 

ili kako mi to skraćeno zovemo DTP ipak postoji 

mogućnost za unos i editiranje teksta uz pomoć alata 

Type (KRATICA T) i paleta Character i Paragraph 

koje se nalaze u izborniku Window.  Dakle u njemu 

sigurno nećemo raditi prijelom časopisa i knjiga jer 

postoje programi koji su za to predviđeni, ali možemo 

napravit recimo dizajn majice, postere, jednostavnije 

letke, naslovnice knjiga ili dizajn web stranice.  

Kada aktiviramo alat Type primijetit ćemo da se 

kursor miša promijenio. Da bi počeli pisati možemo 

jednostavno kliknuti na dio slike gdje želimo da nam 

tekst započne ili možemo kliknuti i razvući okvir u 

veličini koja nam odgovara za unos teksta. Znači razlika 

je u tome kada samo kliknemo nemamo ograničen 

prostor unosa teksta, dok kada kliknemo i razvučemo 

okvir imamo točno određeno područje gdje pišemo te 

kada tekst dođe do ruba okvira, automatski prelazi u 

novi red. Okvir možemo naknadno proširiti uz pomoć 

na isti, ali brži način možemo editirati točke bez da 

mijenjamo alat. 

Osim crtanja staza, s Pen alatom možemo crtati i 

Shapes oblike, a što ćemo crtati biramo u naslovnoj 

traci. Razlika između 

staza i oblika je u 

tome što staze jedino 

vidimo u Paths paleti, 

dok Shapes vidimo u Layers paleti, a kad oblik 

označimo postaje vidljiv i u Paths paleti. Osim toga 

Shapes možemo dodatno mijenjati ispunu, obrub 

i imamo više mogućnosti za editiranje u naslovnoj 

traci. Dakle, da bi stazu vidjeli i editirali moramo ju 

označiti u Paths paleti, a kada je staza označena uz 

pomoć gumbića na dnu palete možemo ju bojati 

ili pretvoriti u selekciju. Da bi stazu ispunili bojom 

morate imate neki sloj u Layers paleti označeni jer 

ispuna i obrub su rasteri. Work Path stazu možemo 

imenovati duplim klikom na nju i to je svakako 

potrebno ako želimo koristiti stazu duže vrijeme. 

Gotove staze i oblike možemo koristiti uz pomoć alata 

kao što su Rectangle, Elipse. Ovo je samo mali početak 

razumijevanja staza i njihovog korištenja jer ima se tu 

još puno za reći i naučiti. 

točaka za transformaciju, slične kao i kod Transform 

alata. Ako postoji višak teksta koji nije stao u okvir to 

vidimo kada označimo tekst u okviru - pojavite će se 

plusić u desnom donjem kutu okvira. Da bi sav tekst 

stao moramo proširiti okvir ili smanjiti veličinu teksta. 

Sada kada ste počeli pisati primijetit ćete da u Layers 

paleti imate drugačiji sloj nego što ste do sada naviknuli 

viđati. Sloj na kojem imamo tekst nije rasterski sloj pa ne 

vidimo ikonu slike već je vektorski objekt i nosi oznaku 

“T”. Dok od je tekst na slici vektor, to nam omogućava 

da ga možemo editirati. Da bi postojeći tekst na slici 

editirali moramo ga selektirati, a to radimo tako da 

aktiviramo Type alatci kursorom dođemo iznad teksta. 

Kada se kursor promjeni znači da možemo kliknuti 

na postojeći tekst i promijeniti font ili boju, dodati 

novi tekst ili nešto treće. Drugi način da edirate tekst 

je dupli klik na sloj sa željenim tekstom i automatski 

ćete aktivirati Type alat i taj tekst postati označen. 

I kako sada uopće editiramo tekst? Kada smo ga 

označili, vidimo da nam je naslovna traka postala 

prilagođena tekstu, a osim toga još više opcija imamo u 

već spomenutim paletama. U Character paleti možemo 

promijeniti font, veličinu teksta, prored između 

slova i redaka, dimenziju teksta po širini i visini, boju, 

p e n  i  s h a p e  a l at i

p i s a n j e 
t e ks ta

nakositi tekst i sl. U Paragraph paleti editiramo tekst u 

odnosu na okvir, lijevo, desno i centralno poravnavanje, 

odmak od ruba, odmak prvog retka i sl. Sve te opcije 

su vam sigurno poznate ako ste ikada editirali tekst u 

Wordu ili nekom drugom programu za pisanje teksta.  

Sve dok imate aktiviran Type alat i sloj, primijetit 

ćete da ne možete koristiti kratice na tipkovnici jer 

svakim pritiskom tipke zapravo pišete tekst. Da bi 

izašli iz editiranja teksta jednostavno označite neki 

drugi alat ili pritisnite kraticu CTRL + D + Enter. 

Osim klasičnog Type alata, u njegovoj podgrupi 

imamo i Vertical Type alat za pisanje uspravnog 

teksta. On sadrži iste opcije kao i horizontalni 

Type alat, samo pišemo u drugom smjeru. 

Kada nam tekst više nije označen mi ga možemo 

transformirati kao i bilo koji drugi sloj uz pomoć 

Transform alata i opcija što nam daje dodatne 

mogućnosti slaganja teksta i stvaranja vlastitih 

dizajnerskih rješenja. Ako poželimo duplicirati Type 

sloj, to možemo tako da odvučemo željeni sloj u Layers 

paleti na ikonu New Layer ili označimo Move alat, 

kliknemo na tekst i pritisnemo tipku ALT ite povučemo 

kursor miša. Na taj način možemo duplicirati bilo koji 

sloj pa i onaj tekstualni.

OZNAĆENI 
TEKST

VIŠAK 
TEKSTA

NASLOVNA 
TRAKA KAD 
JE TYPE ALAT 
OZNAČEN

PROŠIRIVANJE 
OKVIRATYPE SLOJ U LAYERS PALETI

PALETE ZA 
UREĐIVANJE TEKSTA

Pen alat za crtanje uz pomoć točaka

Za crtanje prostoručnih staza

Za crtanje krivulja

Za dodavanje točaka na liniju staze

Za brisanje točaka sa staze

Za promjenu točaka i izvlačenje vodilica

Za označavanje i pomicanje cijele staze

Za označavanje i pomicanje točaka na stazi

Crtanje kvadratnih oblika ili staza

Crtanje eliptičnih oblika ili staza

Crtanje oblika ili staza u obliku trokuta

Crtanje oblika ili staza u obliku poligona

Crtanje linija

Crtanje gotovih spremljenih oblika

Oznaka Shape sloja u Layers paleti

Pen alat (kratica P) nam služi za iscrtavanje staza 

koje kasnije možemo koristi za dobivanje selekcije 

iz te postojeće staze, bojanje unutar staze ili 

stvaranje obruba na liniji staze. Ovaj alat se koristi 

u kombinaciji s paletom Path i alatima ispod 

Pen Selection i Direct Selection Tools (kratica A) 

jer stazu ne možemo pomicati s Move alatom 

ili editirati s drugim rasterskim alatima. Kada 

želimo označiti cijelu stazu koristimo prvi alat Pen 

Selection Tool, a kada želimo označiti, pomaknuti 

ili editirati pojedinu točku na stazi koristimo drugi 

alat Direction Selection.

U podgrupi Pen alata imamo dodatne alate koji 

nam mogu pomoći u stvaranju staza i oblika, a 

po meni najbitniji je Convent Point alat uz pomoć 

kojeg možemo iz obične točke izvući vodilice da 

stvorimo krivulje. U principu uz pomoć tipaka na 

Radna staza

Označeni Shape slojevi
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boje, tonovi i 
kontrasti

uz pomoć kojih određujemo koliko jako želimo 

pojedinu promjenu boje primijeniti. Što više 

pomičemo klizač od sredine to više utječemo 

na ton ili boju slike. Ako nismo zadovoljni 

izmjenama, duplim klikom na klizač se vraćamo 

na početnu poziciju, a pritiskom tipke ALT 

gumbić Cancel nam se pretvara u Reset pa 

tako sve klizače jednim klikom možemo vratiti 

na početnu poziciju bez da izlazimo iz okvira. 

Pa idemo spomenuti neke od opcije koje su nam 

možda za početak najkorisnije i najzanimljivije. 

Jednu smo već spomenuli, a sad ćemo se 

pozabaviti s Hue/Saturation... (kratica CTRL + U) 

koja nam nudi promjenu Hue - boje po principu 

spektra boje, Saturation po principu jačine 

boje te zadnjeg klizača Lightness koji dodatno 

dodaje bijele ili crne u izabranu boju. Izmjenu 

boje možemo primijeniti na cijeli označeni sloj 

(Master opcija) ili na određenu boju na sloju 

(Reds, Blues...) Klikom na Preview možemo 

usporediti sliku prije i poslije izmjene, a opcija 

Colorize nam nudi da cijelu sliku ili označeni sloj 

presvučemo određenom bojom pa na taj način 

možemo napraviti izgled slike u Sepia tonovima.  

Još jedna zgodna opcija je Replace Color, 

gdje možemo izabrati točno određenu boju 

na slici/sloju i samo na njoj raditi, a dolje 

naveden opcije su ako i kod Hue/Saturation. 

Koju boju ćemo izabrati određujemo klikom 

na sliku, koliko tonova neke boje ćemo 

zahvatiti određujemo klizačem Fuzziness. 

Sljedeća zgodna opcija je Black & White... uz 

pomoć  koje možemo određeni sloj ili cijelu sliku 

pretvoriti u crno bijelu, ali uz dodatne opcije 

sami određujemo njezin izgled i kontraste. 

Jako važne i često korištene opcije su Levels i 

Curves, ali su preopsežne za skriptu pa se s njima 

bavimo na tečaju ili instrukcijama.

s m a r t  o b j e k t i 
i  a d j u s t m e n t 
s l o j e v i

Ono što moramo spomenut kod editiranja 

boje na rasterskim slikama preko izbornika 

Image, je to da je taj način editiranja 

zapravo destruktivan za sliku. Što to znači?  

Pa to znači da kad primjijenimo ove opcije 

na određeni sloj, mi trajno mijenjamo 

piksele na tom dijelu slike i ako sliku 

zatvorimo ne možemo se više vratiti nazad. 

Da bi to izbjegli Photoshop nam nudi 

Smart objekte i Adjustment slojeve.  

Smart objekti su napredna funkcija koja nam 

omogućuje da kreirajmo slojeve koji sadrže 

veze prema vanjskim datotekama, kao što su 

PSD, JPEG ili drugi tipovi datoteka pa taj sloj 

možemo recimo smanjivati i povećavati bez 

gubitka kvalitete kao što se to događa sa običnim 

rasterskim slojevima. Smart objekt možemo 

pretvoriti bilo koji veliki rater koji unesemo na 

sliku prije nego ga smanjimo tako da kliknemo 

desnim klikom miša na ubačeni sloj i izaberemo 

opciju Convert To Smart Object. 

Ikona na sloju koja označava da se 

radi o Smart objektu izgleda ovako: 

Ono što pak ne možemo raditi na Smart objektu 

je editirati boju kao što možemo na rasteru, ali 

to smo ionako zaključili da je destruktivno i 

loše pa je pravo pitanje kako to možemo raditi 

na bolji način? Tu u priču dolaze Adjustment 

slojevi koji u principu rade isto što i Adjustment 

opcije u Image izborniku, ali na način da se 

primjene kao poseban sloj iznad označenog sloja. 

Dodajemo ih tako da kliknemo na gumb  na dnu 

Layers palete, a kada izaberemo opciju recimo 

Hue/Saturation nastane nam poseban sloj: 

Opcije za promjenu boje i tonova ćemo vidjeti 

Najčešće korištene opcije za podešavanje boje 

nam se nalaze na vrhu Photoshopa u padajućem 

izborniku Image > Adjustments. Vidjet ćemo 

cijelu listu ponuđenih opcije, a sami naziv nam 

zapravo govori što koja opcija radi. Pa tako 

Brightness/Contrast... nam radi tako da nam 

posvijetli ili potamni sliku te pojača ili ublaži 

kontraste. Kada kliknemo na bilo koju od 

opcija otvori nam se dodatni okvir s klizačima 

Boja je naravno jako 
važan dio editiranje slika, 
a Photoshop nam nudi 
pregršt opcija i alata za to. 
Proći ćemo samo neke od 
njih jer bi o toj temi  mogli 
napisati posebnu knjigu... 

u Properties paleti koja će se automatski 

otvoriti kada izaberemo nek od Adjustment 

slojeva i izgledat će isto ili slično kao 

kad ih otvaramo preko Image izbornika. 

Ono što ćete sljedeće primijetiti kad krenete 

pomicati klizače Adjustment sloja je to da 

ne utječete na boje samo onog sloja ispod, 

već na sve slojeve koji se nalaze ispod tog 

Adjustment sloja. Ako želite to izbjeći i samo 

utjecati na sloj ispod kliknut ćete na prvi, 

skroz lijevi gumb  na dnu Properties palete  i 

na taj način povezati gornji Adjustment sloj sa 

slojem ispod. Drugi način da odredite na što 

će se Adjustment sloj odnositi je da koristite 

ovaj bijeli kvadratić na sloju, a to je maska - o 

njima smo već pričali i znate kako djeluju pa 

znamo da na mjestu gdje je bijelo promjena 

je vidljiva, a na mjestu maske gdje stavimo 

crnu boju neće se aplicirati izmjena boje. 

Ono što je svakako zgodno i korisno je to da 

se mi možemo naknadno uvijek vratiti na taj 

Adjustment sloj klikom na njega, vidjeti što smo 

napravili i ponovno mijenjati boju ili masku u 

Properties paleti prema našim potrebama, a bez 

da smo trajno uništili piksele na našoj slici. Isto 

tako kao i na svakom drugom sloju možemo na 

njega primijeniti Blending Modove ili smanjiti 

Opacity te utjecati manje ili više na boje ispod. 

Možemo također promijeniti redoslijed i 

premjestiti ga, duplicirati ili na kraju i obrisati.


